
Before any quantitative results can be obtained, the  and the  must be
set.

Quant Initialization

detector parameters analysis parameters
Important Note: the system must be before meaningful quant results can be obtained!calibrated

Quant Initialization - Detector Parameters

Detector Parameters are 
accessed via the menu 

command
:Analysis → Setup Detector

The user is allowed to select from a variety of  types. Depending on the window type, the user can select from the 
list of  types, if applicable. Depending on both the window and crystal types, the user can adjust 
the following  parameters: window, aluminum layer, crystal, front contact, dead layer, and ice layer. Not all 
thickness parameters are applicable, depending on the choice of window and crystal. The default  values used by 
Revolution for  and  are shown but cannot be changed by the user. The (at 
Manganese) is editable but it is highly recommended that the user allow the program to determine this value.

Window
Crystal

thickness
Physics

electronic noise Fano factor linewidth

The four 
parameters are also available, 

defined in this diagram (
):

Geometry

angles shown in red

When all  settings are correct, hit  to enter them into the program preferences.Setup Detector OK

Important operating note: A single well-defined  rarely reflects the actual measurement situation. Sample emergence angle
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surface properties cause this value to be ill-defined unless care has been taken to clean and polish the sample flat. In 
addition, the beam is being scanned across the sample from a point source, causing a slightly different emergence angle to 
apply for each pixel being probed. Therefore, the emergence angle value is at best an integrated effective value for the 
sample, and within limits  and  be treated as a  to maximize accuracy of quant 
results (see discussion of  below). 

can should freely adjustable parameter
background subtraction

Quant Initialization - Analysis Parameters

Analysis Parameters are 
accessed via the menu 

command
:Analysis → Setup Analysis

Operating note: There is no straightforward interpretion of the threshold value except in the context of Fuzzy Logic, which 
is beyond the scope of this manual. Likewise, there is no straightforward procedure for adjusting the Peak Sensitivity and 
Element Threshold values to improve PeakID or Quant results. As a general rule, the primary strategy is to gradually reduce 

Analysis Options

Methods →
Determines whether Peak ID functionality is handled automatically by the 
program or allows manual intervention. Also used to select Bulk (ZAF) or 
Thin-Film (modified ZAF) analysis.

Peak Sensitivity → A measure of the peak-to-background ratio that must be exceeded before a 
peak is included for identification. Default value is 3.5.

Element Threshold 
(%) →

A measure of the certainty required to label a peak as belonging to a 
particular element. If the membership function as determined by the fuzzy 
logic engine is less than the threshold value, then the peak does not belong 
to the element being tested. Within the internal database of elements, each 
element has its own measure of probability which is directly compared to 
the threshold value. These values are updated over time as the program 
becomes "smarter." Default value is 40.00.
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Sensitivity; a secondary strategy is to lower the Threshold. 

Show ROIs →

When selected, highlights a spectrum with ROIs 
calculated by the program.

 These ROIs are 
accessible to the user.

Note: these ROIs are not the ROIs associated 
with x-ray mapping or simple EDS acquisition! not

Show Qual. Results → Toggles display of the Qualitative report, which appears below a spectrum.

Show Bkg Subtracted 
→

Toggles display of the background subtracted spectrum. The quality of a 
background-subtracted spectrum is crucial to the accuracy of any Quant 
results! (The background-subtracted spectra are most easily viewed in log 
scale).

Use Standards →
Quantify with Standards. Required for accuracies better 
than about 5%. See  further down this page for more 
information.

Making A Standard

Normalize →
Forces percentage calculations to add up to 100. If  while using 
standards, non-normalized results will be calculated for any elements that 
lack a standard or are specifically excluded.

off

Treat as Oxides →

Attempts to classify elements as common oxides in conventional formulas 
(e.g., carbon dioxide, CO2), according to the  table. 
Normalization is forced (calculated oxide percents will total 100). 

 should be turned  for hydrocarbon (polymer) analysis. The treat-
as-oxides check box will toggle the Normalize, Oxide Percent, and Cation 
checkboxes (see below).

Edit Oxides
Treat as 

Oxides off

Edit Oxides →

Define which oxides to use for oxide analysis. The table consists of all 
commonly encountered oxides in EDS work. Entries can be manipulated 
with certain limitations. For example, CO2 can be changed to CO, but 
N2O5 cannot be changed to an oxide without Nitrogen. Note: changes to 
the Oxide table are not saved until both the Oxide table dialog  the 
Setup Analysis dialog are dismissed using the  button!

and
OK

Element by Difference 
→

Element by 
Stoichiometry →

Result Options
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Display by → Set Quant results to display by Chemical Symbol, Element Name, or Atomic 
Number. Default is .Chemical Symbol

Sort Results by →
Set Quant results to sort by Chemical Symbol, Element Name, Atomic 
Number, Weight Percent, Atomic Percent, Oxide Percent, or Peak Energy. 
Default is .Atomic Number

Weight Percent → Toggle display of Weight Percent.

Standard Deviation → Toggle display of Standard Deviation. Only applies to calculation of 
Weight Percent.

Atomic Percent → Toggle display of Atomic Percent.

Min. Detectability 
Limit →

Toggle display of Minimum Detectability Limit. Only applies to 
calculation of Weight Percent.

Oxide Percent → Toggle display of Oxide Percent. Only available if  is 
(see above).

Treat as Oxides on

k-Ratios → Toggle display of k-ratios. See discussion of  and 
analysis methods.

ZAF Cliff-Lorimer

Intensities → Toggle display of line Intensities. The intensities are the integrated counts 
for each ROI that is calculated by the program.

Probability →
Toggle display of Probability. Probability is a confidence level that the 
results are correct. For Quant results, the probability values are a 
conglomerate of several of the results for each element.

FWHM →
Toggle display of representative full-width at half-maximum for an element. 
Note: the only meaningful measure of resolution is the FWHM at the 
Manganese line.

Use Line Labels →

ROI Counts →

Cations →

where  is concentration,  is x-ray line intensity, and  is the ZAF matrix correction. The subscript  refers to the same 
quantities for the standard element in use for the analysis. If standardless analysis is being used, a mathematical model of 

Quant Initialization - ZAF and Cliff-Lorimer Corrections

Revolution 1.5.6 uses a standard ZAF correction for bulk analysis and a modified ZAF for thin-film analysis; the use of 
standards is  for accurate results. highly recommended

The basic form for the ZAF correction is:

C I F SD
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the standard is substituted.

which comprise effects due to atomic number (Z), which includes the effects of backscattering and stopping power, x-ray 
absorption (A), and x-ray fluorescence (F).

The ZAF correction generally applies to bulk specimens, defined as one that is thick enough that the x-ray generation 
volume for each element is contained within the sample. If bulk effects can be neglected (in thin-foil samples for example), 
the complex ZAF correction can be replaced by the Cliff-Lorimer simplification, in which a "k-factor" characterizes the 
relationship between elements.

The Cliff-Lorimer approach can be extended to multielement systems by determining k-factors relative to a single element 
(often Si). Experimental determination of the k-factors accurately reflects both x-ray absorption effects in the sample and x-
ray detector efficiency. Note the mathematical similarity between the k-factor and the ZAF correction (F) in Equation 1. 

The quantity  can be further broken down into multiple 
corrections:

F

For any particular element, the ratio of intensities (sample/
standard) is the k-ratio (a  quantity):measured

For any 2 elements  and  this ratio is defined as the k-factor 
(an  quantity):

A B
entered

Strictly speaking, the ZAF correction requires a  for each element that is being quantitatively analyzed. The Cliff-
Lorimer correction requires a  for every element that is being quantitatively analyzed, but a standard is only 
required for the initial characterization of the detector. Since it is ZAF only, Revolution cannot use, nor does it require, k-
factors. The ZAF k-ratios reported in quantitative results are not related to the Cliff-Lorimer k-factors. 

standard
k-factor

Peak Identification

Revolution's Peak ID feature allows the user to make quick and accurate identifications of elements in a spectrum. Clicking 
on the  button in the upper left of the EDX Spectra Mode Toolbar (see below) automatically analyzes the spectrum and 
presents an identification report. Peak Identification can be performed in either  or mode (below).

id
automatic manual

A sample spectrum in a catalog is shown below, before identification:

When a catalog is open and a spectrum is being acquired or has been acquired, the user may hit the  button (or select
the menu item) at any time to perform a peak identification. During an acquisition, the peak 
identifications may "lock" (appear) and "unlock" (disappear) until sufficient statistics are obtained.

id
Analyze → Identify
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The element labels are 
displayed in proximity 

to each peak (here, 
Gold and Copper):

 can be 
independently overlaid 

at any time by right-
clicking and selecting

(Gold 
shown):

KLM markers

Open KLMs

There are three additional options available with the qualitative PeakID capability, all accessed through the
 dialog box (choose  from the  menu): , , and 
.

Setup Analysis Setup Analysis Analysis Show ROIs Show Qual. Results Show 
Bkg Subtracted

When  is turned on, the Peak ID routines will automatically calculate a FWHM value for each identified peak 
and overlay the spectrum. Note that these ROIs are internally calculated and not accessible to the user. If the

 for an element happens to be turned on, the  function will override the manual ROI definition and 
overlay the true FWHM value for the element.

Show ROIs
manual ROI 

marker Show ROIs

9/22/06 11:30 AMQuant Initialization

Page 6 of 17file:///Users/dirkdark/Desktop/Installs%20(7.0%20driver)%20MASTER/Revolution%201.6.0%20Mac/Documentation/manual/30_5-edsinfo16.htm



The 
checkbox 

performs a background 
subtraction on the 

spectrum (shown in log 
scale for clarity):

Show Bkg 
Subtracted

The 
checkbox 

performs a qualitative 
analysis on the 

spectrum and presents 
the results in a small 
report (highlighted). 
What appears in the 

report is determined by 
selections in the

dialog box.

Show Qual. 
Results

Setup 
Analysis

The report is able to identify primary peaks in the spectrum, assign elemental IDs, list relative intensities, and a probability 
(see  for definitions of these report items). The intensities are integrated counts in the element ROIs. The 
probability can be strongly affected by even a small miscalibration. Again, it is critical that a precise  be 
performed for accurate PeakID results.

Setup Analysis
calibration

There may be times when the Auto Peak ID returns questionable results. This may occur if an element's entry in the Fuzzy 
database is skewed, either because of poor calibration or a previous lack of identification. If a user knows what elements are 
present, the automatic capability can be manually overidden to force the Peak ID routines to analyze only selected 
possibilities. The ability to include or exclude elements from analysis has been incorporated into a master element periodic 
table. 
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Access this table by 
right-clicking in a 

spectrum window and 
selecting

from the 
contextual menu:

Edit 
Elements

By default, all elements 
are set to 

(except for a small 
group of elements that 
are turned off because 

they are rarely 
analyzed). By clicking 

any element, it will 
toggle on, off, and back 

to AutoID, with the 
requisite color change 

for easy determination.:

AutoID

The three states are defined as:

: Revolution makes all decisions about whether to include an element as a possibility in the quant routines. 
This is the default state, recommended for most work.
AutoID

: The user forces Revolution to  an element in the list of possible identifications. Revolution will try to 
continue including the element, even if it would normally be discarded from the ID list. This is useful if the element 
is at such a low concentration that its statistics are poor, or when the element has lines very close to other elements, 
causing the program difficulty making an automatic identification.

On include

: The user forces Revolution to  an element in the list of possible identifications. Revolution will try to 
continue excluding the element, even if it would normally be added to the ID list. This is useful if the element has 
lines very close to other elements, causing the program difficulty making an automatic identification.

Off exclude

The last configuration set by the user is remembered going forward; however, the user can  a configuration and
then  it later for convenience. The  button places the entire table into its original default state. A  on 
any element allows one to set it to either AutoID, On, or Off, and has the added ability to turn the entire table off.

Save
Open Reset right-click

Peak Identification Operating Notes

When the Manual Identify Setup periodic table first appears, certain elements may be autoselected. The elements that 
are autoselected are picked first from current KLM markers (if any), then from the previous Quant results (if present), 
and then from the previous Manual ID elements (if previously selected). If none of these criteria match, the table will 
be blank and no Manual ID is possible until at least one element is selected.
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The X-ray energy axis (x-axis) will sometimes start with a non-zero number. This is because the spectrum, once 
autocalibrated, is adjusted by a software gain and offset so that peaks line up precisely according to accepted 
reference values. X-axis labels change accordingly, starting at the computed offset, even if that is a negative offset. 
So to some degree, aesthetics is traded for accuracy. A future feature will allow custom axis settings for reports.

Sometimes Peak ID element labels are written on top of one another. The automatic label placement routine can't 
always keep each label in the clear if there are too many in one place. Either turn off the labels for some elements, or 
resize and zoom the spectrum window to make more space. Future updates will handle this presentation aspect better.

When the spectrum is magnified for clarity, sometimes there appear more KLM markers for an element than there are 
Peak ID labels, or vice versa, instead of the expected one-to-one correspondence between the identifications and the 
markers. To avoid clutter, This is because Peak ID identifies whole peaks, and not all the energy lines that may 
contribute to each peak. This is done to avoid clutter, and helps avoid the problem noted in the previous bullet.

In the Peak ID results for a spectrum, sometimes the probabilities are quite a bit less than 100%. This does not mean 
the ID is wrong. EDX calculations, especially the default ZAF standardless method, is not a science of 100% 
certainty. If probabilities for the elements of interest seem too low, there may be problems with the spectrum such as: 
(especially) miscalibration, insufficient acquisition time, inaccurate detector parameters, or contamination.

An older spectrum may yield identifications that are not correct because it was acquired under a different calibration. 
However, all spectra have their own calibration data saved with them, and can be modified to bring the spectrum 
back into calibration.

While a spectrum 
is on screen, the 

Spectrum Info 
Editor is accessed 

via the menu 
command

, 
or by right-

clicking and
selecting

:

File → Get Info

Edit Info

In the default configuration of Revolution, some elements in the database have a relatively low probability 
assignment. It is possible that these peaks are visible in the spectrum but are not identified by the PeakID routines. 
The following procedure can be used to modify the Fuzzy database and create a correct identification.  outside 
of calibration errors, the most likely cause of non-identification is poor statistics; before resorting to a modification 
of the database, make sure the problem cannot be fixed by acquiring for a longer time.

Note:
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Example spectrum 
after PeakID is 

performed which 
shows a single 

unidentified peak:

Select
from 

the toolbar menu.
The

dialog is 
displayed,

listing the 
elements that 

Revolution knows 
about for the 
spectrum in 

question (it can be 
moved so as to not 

obscure the 
spectrum window):

Analyze → 
Learn Peaks

Learn Peaks

only

KLM markers for 
the known 

elements are 
automatically 

displayed
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Clicking on any 
element in the 

Learn Peaks 
dialog will 

automatically 
overlay the KLM 

marker for that 
element.

With 20-20 
hindsight, the 

result for Sodium 
is shown:

The user can select 
as many element 

markers as 
necessary in an 

attempt to 
manually identify 

the unknown 
element(s). When 

the manual 
identification has 
been made, click 
OK in the Learn 

Peaks window.

Click yes in 
response to the 
dialog box that 

follows to update 
the element 

database

In most situations, 
the previously 

unidentified 
element will be 

identified, and the 
element will 

successfully be 
identified in 
subsequent 

measurements:

There are rare or unusual situations in which the Learn Peaks procedure still does not successfully identify peaks. 
Assuming that the calibration has been performed correctly, it is likely that one or both of the two parameters which 
control the PeakID calculation, and , are not adjusted appropriately for the sample in question 
(see  for more information).

Sensitivity Threshold
Setup Analysis

In contrast to the above discussion, peaks that are consistently identified but which the user is certain do exist in not
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the spectrum can be . The procedure is roughly the reverse: in the Learn Peaks dialog (above), Revolution 
will display all elements it thinks it knows about. An element can be clicked  and should  from the 
identification; however, this procedure is significantly more dependent on the values selected for Sensitivity and 
Threshold, and may not work as anticipated. A circumstance where an element must be "unlearned" is significantly 
less likely if the sample has good statistics associated with it to begin with.

unlearned
off disappear

Analyzing all possible strategies for modifying the values of Sensitivity and Threshold, especially for unlearning 
peaks, is outside the current scope of this manual. Any user with problems in this area is encouraged to contact 

.
4pi 

support

Quant Analysis

With a catalog open and 
showing an acquired 

spectrum, click the 
Quant button on the 

EDX toolbar to activate 
quantitative analysis 

and display the 
quantitative results 

report:

: on slower 
machines,

leaving the  button 
selected during 

acquisition can cause 
undesirable system 

slowdowns as 
Revolution 

continuously tries to 
analyze the changing 

spectrum.

Note

qnt

Quant Operating Notes

For meaningful quant results, it is  that all detector settings are correct, that the system has been 
autocalibrated, and that the correct parameters are entered in the EDX toolbar. If not, the quant results are likely to be 
wrong. Also review the reported eV/channel. A exact even-integer value such as the 10eV/channel default is unlikely 
if an autocalibration has been done.

critical

If the  checkbox (above) is turned on while performing quant, new ROIs overlays calculated by the quant 
routines will override the  overlays.

Show ROIs
manually defined ROI

Be sure that the beam energy (the kV field in the EDX toolbar) is set correctly. If analyzing an existing spectrum, 
check the Spectrum Info and apply the current program setting .if appropriate

EDX 
Spectra 

Toolbar:

Spectrum 
Info Editor:

Be sure the Emergence Angle is set correctly. As with beam energy, this number is critical for accurate analysis. If 
analyzing an existing spectrum, check the Spectrum Info Editor and apply the current program setting .if appropriate
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Detector 
Setup 

Dialog:

Spectrum 
Info Editor:

Check that the full-width at half-maximum resolution (FWHM) is correct. FWHM, normalized to Manganese, is less 
critical to accuracy but can cause incorrect identification of elements. If analyzing an imported spectrum that was not 
tagged with detector resolution information, the program will default to your detector's setting. Check the Spectrum 
Info and apply the current program setting . Alternately, edit the resolution in the FWHM field. If you 
then save or export the spectrum from within Revolution, the FWHM will be saved with it.

if appropriate

Detector 
Setup 

Dialog:

Spectrum 
Info Editor:

If an element that is not in the sample continues to be identified by Revolution, try using  → to 
un-learn the errant peaks by deselecting the offending elements on the  periodic table (see above, this 
page).

Analyze Learn Peaks
Learn Peaks

If a peak can't be removed by unlearning, try adjusting the  in the  dialog box.Sensitivity Setup Analysis

Analysis Setup 
Dialog:

Making a Standard
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Before a standard 
can be made, a 

spectrum must be 
acquired (in this 

example, a Copper 
and Gold sample, 

independently 
known to be a 40/60 

mix):

A quant analysis 
performed on the 

spectrum should be 
close to the correct 

analysis (blue):
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To create any standard, 

, select
, and fill out the dialog box 

according to the known composition:

make sure the 
spectrum to be used is displayed in the 

catalog Analyze → Make 
Standard

Enter values for up to 12 elements in the 
current spectrum in terms of: Weight 

Fraction, Weight Percent, Atomic Percent, 
Oxide Percent, or Number of Atoms. The 
values must sum close to 1.0 or 100% in 

order for the OK 
button to be enabled. Clicking OK makes 

the current spectrum a standard.

Elements may be individually excluded. 
See examples under

(below) for more information.
Using a Standard

The number of standards may be extended 
beyond the available edit fields in the 

dialog box.
See discussion of and

below.
Import Export

Making the spectrum 
a standard 

necessarily changes 
the analysis. The 

Weight Percent and 
probability match 

the definition of the 
standard (blue). The 
spectrum is listed as 

a standard for 
reference

(red). The

are generally 
reduced because the 

statistics exclude 
alternate analyses 

(green):

Standard 
Deviation and MDL
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Operating note 1: For correct Quant analysis on any particular spectrum, all standard spectra as well as the target 
spectrum must have been acquired with a common ev/channel setting and the same accelerating voltage.

Operating note 2: The full Revolution Quant module must be active for either standardless quant (also known as "semi-
quant") or quant with standards.

Operating note 3: To remove a standard from consideration temporarily, close the catalog that contains it. Alternately, 
select the spectrum being used as a standard, select , and exclude any or all elements from 
consideration. To eliminate the spectrum as a standard, click on  in the window. See the examples 
below for more clarification.

Analyze → Edit Standard
Discard Setup Standard

Using a Standard

Revolution  for standards when doing standards-based analysis. The following examples describe 
the way Revolution interacts with standards:

checks all open catalogs

. Given a single Cu-Au sample, create 2 catalogs and acquire spectra into each. A spectrum from Catalog 1 is 
used to make a Gold standard. A spectrum from Catalog 2 is used to make a Copper standard. Neither element has been 
excluded. Analysis of any subsequent spectrum in any catalog will use the Gold standard from Catalog 1 and the Copper 
standard from Catalog 2 to perform quant.

Example 1

. If Catalog 2 is closed, no subsequent spectrum can be analyzed with the Copper standard until 
Catalog 2 is reopened. Such analysis will be mixed (and so noted in the report): Gold will be analyzed with the standard 
and all other elements (including Copper) will be analyzed using standardless quant. Note that for this single-element-
standard example, the same thing can be achieved by excluding Copper rather than closing the catalog.

Extended Example 1

. Given a single Cu-Au-Mn sample, create a single catalog with 2 spectra. Spectrum 1 is used to make a Gold 
and Copper standard. Spectrum 2 is used to make a Gold and Manganese standard. No elements from either standard are 
excluded. Revolution will use as the Gold standard that spectrum which has the highest intensity Gold peak, under the 
assumption that the higher intensity peak has "better statistics." The same applies even if the 2 spectra are in different 
catalogs.

Example 2

. It is desired to use the  Gold standard instead of the default high-intensity standard. 
This is accomplished by selecting the Exclude checkbox in the Setup Standard dialog box for the spectrum with the higher 
Gold intensity.

Extended Example 2 low-intensity

. Given 3 Cu-Al-Mn samples, but with different percentages of Cu-Al-Mn in each sample. Acquire a spectrum 
from each sample into one or more catalogs. Create a standard for each spectrum. Analysis of any subsequent spectrum will 
use the highest intensity peaks found in any of the 3 spectra for each element, under the assumption that a higher intensity 
peak has "better statistics."

Example 3

. To modify the usage of the highest intensity peaks from multiple standards, edit each standard to 
Exclude any element to get the desired dependence.
Extended Example 3

. Spectrum 1 is used to make a standard per the method of Weight Fraction. Spectrum 2 is used to make a 
standard per the method of Atomic Percent. Revolution will perform an internal conversion so that both standards can be 
used.

Example 4

Importing and Exporting a Standard

Data in a standard can be exported to disk for safekeeping. Simply choose the  button in the Setup Standards 
window. If the standard is ever lost or corrupted, it can be imported again by using the  button in the Setup 
Standards window.

Export
Import

An exported standards file can be opened with a text editor, edited, resaved, and imported again. This technique can be 
used to extend the number of elements in the standard to beyond the twelve that are displayed in the 
window.

Setup Standards

The file is formatted in the following way:
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[Global Factors]
Order=Descending
Number of Elements=2

[Type of Concentration]
Weight Fraction=1
Weight Percent=0
Atomic Percent=0
Oxide Percent=0
Number of Atoms=0

[Concentrations]
Element_1=Al
Concentration_1=0.600000
Ignore_1=0
Element_2=Cu
Concentration_2=0.400000
Ignore_2=0

The format of the file should be more or less self-explanatory. The  determines whether elements with the lowest 
concentrations or highest concentrations appear first when displayed in the  window 
( or ). The  be set correctly. Only one  should be set to 
true. For each element, the  must be specified, followed by the  (a value between 0 and 
1.0), followed by the  setting, which determines whether an element is excluded from the standard or not.

order
Setup Standards

Ascending Descending number of elements must concentration type
two-letter designation concentration

ignore

The file will not be imported if an illegal 2-letter element designation is used, or if there is a formatting error in the text file. 
If the concentrations do not add up to 1.0 (or 100%, as needed), the file will be imported, but the OK button will only be 
activated if the sum is close enough to the 100% point.
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